Votre site Internet avec
Adobe GoLive 4.0

1.1. Précautions préliminaires

» Une connaissance basique d'Internet, de Windows et d'un traitement de texte sont utiles sinon

* Le contenu de ce site n'est pas tres élaboré mais il est congu uniqguement dans un but pédagogique.

» Pour débuter, faites simple sinon simpliste. Vous ajouterez vos effets visuels et autres fantaisies
lorsque vous posséderez les outils de base.

* La connaissance d'un éditeur Html n‘'empéchera jamais de connaitre les balises source du langage
Html [oui, je sais, je me répéte... mais toutes les "signatures" du Web vous le diront].

1.2. GoLive

Adobe GolLive ravira de par son interface les concepteurs graphiques mais risque de décontenancer
compléetement les habitués de la bureautique. De plus un écran de 19 pouces ou plus ne sera pas un
luxe car les palettes de travail fleurissent de tous c6tés. GoLive vous donnera la possibilité de
"sculpter" votre page Web sans devoir vous occuper de multiples tableaux imbriqués (puristes du
code Html s'abstenir...).

Dans tous les cas, GoLive 4.0 est un produit trés complet et trés performant. Notre but ici n'étant pas
de faire une aide détaillée de GoLive, nous nous cantonnerons volontairement aux fonctions
élémentaires afin de réaliser une premiere prise en main.
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1.3. Plan du site

Toujours dans un esprit didactique, ce site comprendra un page de présentation de l'auteur (c-a-d
vous) et 3 "sous-pages" consacrées a son chanteur préféré, ses loisirs préférés et un portrait chinois.
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1.4. Mise en place des pages du site

* Ouvrez le programme Golive.
Démarrer > Programmes—> Adobe - GoLive4.0> Adobe GoLive 4.0

» File > New Site> Blank. Nous mettrons ainsi tous les éléments de notre site (pages Html,
images, etc.) dans le méme dossier (soit siteGoLive).

File Edit Wiew Stle Fomnat Special Site Window Help

Hew Chil+h e » = - <1 =
Mew Site Blank... .-'-‘-.It+EtrI+N

S |||

Mew Blank Site

Mew Site  [siteGiolive

In Falder  |C:4

¥ Create Folder Browse... |
Cancel |

« Comme l'écran est quand méme un peu encombré, je suggere de fermer la fenétre appelée "Palette"
pour ne garder que cette dite "de l'inspecteur” et la fenétre d'édition.
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» Golive en créant le répertoire de votre site (siteGoLive) a aussi créé un fichier index. Ce fichier
(la page de présentation) sera la page d'accueil [ou homepage] de votre site. Par convention, on
appelle toujours ce fichier "index.htm" ou "index.html". C'est le fichier ouvert par défaut par les
navigateurs Internet.

Nous devons donner un titre a cette page Web. C'est le titre qui apparaitra tout en haut dans la
fenétre du navigateur. Effacez "Welcome to Adobe GoLive 4" pour y inscrire "Mon site Internet"

Layout L3 Frames [ Source \i
ko Site Intermet

Lave As HE

Dans : Ia siteGolive j ﬁl

Mo Iinde:-: Erreqistrer

Tvpe: I HTHML Document [ html] j Al |




File > Save Aspour enregistrer la page avec cette modification du titre. Comme cette page existe
déja car elle a été crée par défaut lors de I'ouverture du nouveau site, vous pouvez remplacer le
fichier existant.

« On crée maintenant la page consacrée a votre chanteur préfre. New.
Changer la mention "Welcome to Adobe GoLive 4" pour y inscrire "Mon chanteur préféré”.
On enregistre directement cette page (vidéle > Save Asavec commdéNom "chanteur".

» On reprend la méme procédure pour les autres fichiers. Fd#e® New.
Changer la mention "Welcome to Adobe GoLive 4" pour y inscrire "Mes loisirs préférés".
Enregistrer la page, toujours dans SiteGoLivelle(=> Save A3 sous IeNom de "loisirs".

* Onreprend la méme procédure pour les autres fichiers. Fd@ée3 New.
Changer la mention "Welcome to Adobe GoLive 4" pour y inscrire "Mon portrait chinois".
Enregistrer la page, toujours dans SiteGoLivElle(=> Save A3 sous ldNom de "chinois".

1.5. La page de présentation (index.htm)

* Revenons a la page de présentation. Pour ce faire, on peut (hotamment) p&sSketp&@pen
- dossier "SiteGoLive*> index ouFile > Open Recent Files> index.
On retrouve la mention "index.htm dans le bord j%% Adobe GoLive - index. html
supérieur gauche de la fenétre de I'éditeur.

* Nous allons mettre un fond de couleur par remplacer le gris sinistre mis par défaut.
Appelez la palette des couleuvsew - Color Palette On va retenir dans cette palette I'onglet
des "couleurs sires" [web safe colors] comme indiqué ci-dessous.

Imﬂmwﬁﬁ\‘

Dans cette palette de couleur, on retiend, par exemple, une couleur bleu ciel.

Colar Palette
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Palette | 255 Colors E

On cligue alors dans la couleur bleu ciel sélectionnée de la palette de couleur et tout en maintenant
le bouton de la souris enfoncé, on la dépose sur I' I'on trouve dans le bord supérieur

gauche de la fenétre [drag anddrop]. On peut refermer pour l'instant cette palette de couleur.
Veillez que votre couleur de fond soit toujours compatible avec votre couleur de texte. Si les go(ts
et les couleurs ne se discutent pas, votre texte et votre présentation doivent toujours rester lisibles.



» On appelle la fenétre "PaletteView - Palette Cliquez sur le premier élément et déposez-le sur
la fenétre de I'éditeur.
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Layout Grid |j

La philosophie d'Adobe GoLive est de faire de votre page Web un énorme tableau ou vous
disposerez a votre guise les différents éléments constitutifs de votre page. On détermine alors dans
l'inspecteur (si absent View Inspector), une largeur [width] de 800 et on ne manque pas de

confirmer avec le petit sigr<.

Lavaut Grid [nspectar
Width IEEIII 7] —

[ tiniize |
Height EO0

On fait de méme pour la hauteur [height] soit 600. Et il faut toujours coni€mer

Layaut Grid Inzpectar

Width ann
[ Etmiee I

Height E00 ﬁ%

« Onvainscrire le titre (a ne pas confondre avec le titre de la page Web, celui qui apparait dans le
haut de la fenétre du navigateur). Dans l'objet Palette, on prend le second élément (Text Box) que
I'on dépose sur la fenétre de I'éditeur.

Palette

Layout Text Box IJ

On centre alors la boite de texte ainsi crée. dld O
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On cligue dans la zone de texte et on encode le titre soit : Mon site Internet. On centre, on met en
gras et en taille 7.

== 8 7z 1|7 =

On "chipote" la zone de texte pour I'élargir et avoir quelgue chose qui ressemble a ceci.

- Mon Site: Internet

Il ne reste plus qu'a donner une couleur (par exemple bleu marine) a ce texte. Le systéme est
identique a celui utilisé pour mettre une couleur de fond a la Wame.~> Color Palette si celle-

ci n'est pas présente. On sélectionne une couleur dans #hdglet met le texte en surbrillance.

On revient a la palette de couleur et on cligue sur la fenétre avec le coloris retenu (marine). Tout
en gardant le bouton de la souris enfoncé, on dépose la couleur sur le texte mis en surbrillance.

» On prend une autre boite de texte dans la palette (\%ieFaaIette} gue I'on dépose dans la
fenétre de I'éditeur en dessous de "Mon site Internet”. On la centre et on l'agrandit, en hauteur mais
surtout en largeur.

On entre ses coordonnées soit :

Van Lancker Luc (nouvelle ligne = Maj + Enter)
Rue du "Beau Site", 69 (Maj + Enter)
7700 Mouscron (Maj + Enter)

Belgium

» On peut modifier le format de ce texte. Mettre le texte en Surbrillance. On aligne de fagon centrée
et on prend par exemple, une taille 5. On ajuste alors la dimension de la boite de texte.
» On prend une troisieme boite de texte (V'ré\/\PaIette) qgue I'on dépose dans la fenétre de

I'éditeur en dessous de la boite avec les coordonnées. On la centre et on I'agrandit.

On clique dans la boite de texte et on demande
une liste a puces.

IInnumbered List

On encode alors * Mon chanteur préféré
* Mes loisirs préférés
» Mon portrait chinois

* Nous allons maintenant effectuer les liens (pour rappel, Html est hypertexte). Nous allons relier
"Mon chanteur préféré" a la page "chanteur.htm".

Mettez "Chanteur préféré" en surbrillance et cliquez l'icbne
de lien hypertexte o8pecial> New Link.




La fenétre de l'inspecteur se présente ainsi. Pour trouver l'adresse (URL) du fichier, on active le
boutonBrowse...pour parcourir le disque dur.

T ext Inspector

| | Litik. \L.ﬁt_l,lle \i.ﬂ.ctinns

IRL |[E mpty Referencel]

[@] ™| Absalute En:uwsgl.. |

On ouvre le fichier "chanteur"

E:.:phj[g[:la siteGolive j ﬁl

‘chanteur
chinaiz ['\X)

indey

izirs

Mom : Ichanteur Dlrerie I
Tupe: | &1 Files [+%) | Annuler |
v

On procéde de méme pour "Mes loisirs préférés" et pour "Mon portrait Chinois".

» Enregistrez votre travaikile - Save
1.6. La page "Mon chanteur préféré" (chanteur.htm)

» Passez pdfile > Openpour ouvrir la page chanteur.htm. On peut aussi passer par l'icbne

26, |

v chanteur html
index. hitrl
loizirz. btml
chinoiz. htrl

« Donnons une couleur d'arriere-plan a la page. Avec la palette de I'Inspecteur ouverte (View
Inspector), on clique sur licol=l. Avec un double clic, sur la zone Background / Color, on ouvre
la palette de couleurs. On choisit une couleur et on la transporte (drag and drop) dans la zone de
couleur de l'lnspecteur.

— Background

[ Colar I—[%

» Pour respecter la technique de GolLive, on fait le quadrillage de la\iage> Palette >
gue l'on transporte sur la fenétre principale de I'éditeur. Dans la palette de l'inspecteur, on fixe les



attributs de largeur [width]et de hauteur [height]de la page, sans oublier de co#itezer
dimensions encodées.

Pour faciliter la vie du lecteur, on inclut des "outils de navigation" pour lui permettre de se

mouvoir dans votre site sans passer par les boutons "Précédent" et "Suivant" de son navigateur
Internet. Dans le cadre de ce travail, nous utiliserons, dans un premier plan, des mots pour faire les
liens mais il est plus sympathique a I'avenir de prévoir des petites images.

Procédure pour la boite de texte : $talette > . On élargit cette boite de texte et on l'aligne
a droite = . Tapez "Page d'accueil" dans la boite de texte que l'on aligne également =droite

Mettre "Page d'accueil" en surbrillance pour effectuer le lien vers la page de présentation.

Activation de l'icone de lie ®2 , puis dans I'lnspecteur se dirigBr¢wse) dans le dossier
"SiteGoLive" sur le fichier index.htm.

Créons un nouveau paragraphe. Toujours la méme procédure de boite de texte. On élargit cette
boite de texte et on I'aligne au cen 5. On encode le titre dans la boite de texte (& ne pas
confondre avec le titre de la page Web, celui qui apparait dans le haut de la fenétre du navigateur)
soit "Mon chanteur préféré".

On peut centre le tex = . On donne au texte une taille 5, on le met en gras et en couleur.

On va maintenant créer un tableau (invisible) d'une ligne et d'une colonne.
Vous découvrirez bien vite que les tableau sont des éléments trés importants pour le design d'une
page Web et que leur usage est donc trés fréquent.

View =2 Palette> gue I'on transporte sur la fenétre de I'éditeur de GoLive. On centre le
tableau . Dans l'inspecteur (View> Inspector), on encode les données suivantes.

Table Inzpector

| Table “‘ow {Cell | Hidden

— Dimensions

Rows |'| Columnz |1

Width 40 I Fercent j
Height | | suto =]

— Appearance

Border IEI ™ Calar I—
Cell Pad IE Cell Space |2

Alignment I Default = I

- N'oubliez pas de confirm# chaque nouvelle valeur encodée.
- La case "Cell Pad" entourera le texte des bords du tableau de 5 pixels d'espace libre.

Vous encodez alors dans la cellule du tableau vos préférences concernant votre chanteur préféré
et les commentaires qu'il vous inspire.



On enregistre son travakile - Save

1.7. Premier test dans le navigateur

A ce stade vous pouvez déja admirer I'ébauche de votre site sous un navigatSpecsali®

Show in Default Browserou Show in Browserou E" .

Vous devez avoir quelgue chose qui ressemble a ceci :

Mon site Internet Page d'accuefl
van Lancker Luc Mon Chanteur préféré

Rue du Beau Site, 69
7700 Mouscon

Belgium
e Mon chanteur préféré Jacques Brel
* Mes loisirs préférés
« Mon portrait chinois "la pluie est traversiére'

Vérifiez en cliquant sur "chanteur préféré" de la page de présentation, si le lien vers "chanteur" est
bien actif. De méme, dans la page chanteur, en cliquant sur "page d'accueil", vous devez revenir a
la page index.

1.8.La page "Mes loisirs préférés"” (loisirs.htm)

FaitesFile = Open pour ouvrir la page loisirs.htm.

On donne une couleur d'arriere-plan a la page. Avec la palette de I'lnspecteur ouvert® (View

Inspector), on clique sur licol=). Avec un double clic, sur la zone Background / Color, on ouvre
la palette de couleurs. On choisit une couleur et on la transporte (drag and drop) dans la zone de
couleur de l'Inspecteur.

Dans la philosophie de GolLive, on fait le quadrillage de la pdge: - Palette > que

I'on transporte sur la fenétre principale de I'éditeur. Dans la palette de l'inspecteur, on fixe les
attributs de largeur [width]et de hauteur [height]de la page, sans oublier de co#itezer
dimensions encodées.

On met les outils de navigation. Procédure pour la boite de textePadeiite > . On élargit

cette boite de texte et on l'aligne a dri g Tapez "Page d'accueil" dans la boite de texte que
I'on aligne également a dro’=. Mettre "Page d'accueil" en surbrillance pour effectuer le lien
vers la page de présentation. Activation de l'icéne de 21 puis dans I'Inspecteur se diriger
(Browse) dans le dossier "SiteGoLive" sur le fichier index.htm.

On met le titre. Toujours la méme procédure de boite de texte. On élargit cette boite de texte et on
l'aligne au centre & . On encode le titre dans la boite de texte soit "Mes loisirs préférés".

On peut centre le tex = . On donne au texte une taille 5, on le met en gras et en couleur.



» En Html, tout est tableau! Pour une mise en page efficace, les tableaux sont incontournables. Nous
profiterons donc de cette page pour faire plus ample connaissance avec les tableaux.

Notre but sera de réaliser la présentation suivante.

La Formule 1
La souris
La sieste

¢ On demande un tableau de 3 lignes et 3 colonnes (par défaut dans GdieweR Palette >
icone du tableauque I'on transporte sur la fenétre de I'éditeur. On centre le te * 2dDans
l'inspecteur (View> Inspector), on encode les données suivantes.

T able Inzpector

| | Table “'Baw " Cell | Hidden

— Dimenzionz

Raows |3_ Colurnins |3_
Width |BEI IF'en:ent j
Height | [t =]
— Appearance
B order |4— ™ Color I_
CelPad [0 CelSpace [z

» On sélectionne la cellule supérieure gauche. Ce qui est un peu délicat. Vous devez avoir ceci.

I

» La fenétre de l'inspecteur se positionne sur l'onglet "Cell" et vous y encodez les données suivantes.
Puis vous entrez le texte souhaité.

T able Inspector

| | Table “|Raw 7 Cell “Hidden

Yertical Alignmett I Drefault e I
Harizontal Alighment I Center i I
Row Span |1 ¥ Colar I
Column Span |1

width [z |Pecent =]
Height | I Auta j

» On procéde de méme pour la cellule centrale et la cellule inférieure droite.



» Et nous terminerons par l'insertion d'une ligne horizontaey - Palette > j On centre
cette ligne . On peut modifier quelques paramétres dans la fenétre de I'lnspecteurXView

Inspector).
se | — |
widh  [300 [Pl =l
Height [z
aligrment | —JT=T |

» Enregistrez votre travaikile - Save

1.9. La page "Mon portrait chinois" (chinois.htm)
» Passez pdfile > Open(ou tout autre moyen) pour ouvrir la page chinois.htm.

* On donne une couleur d'arriére-plan a la page. Avec la palette de I'lnspecteur ouveri2 (View
Inspector), on clique sur licol=). Avec un double clic, sur la zone Background / Color, on choisit
une couleur selon une procédure maintenant habituelle.

» Dans la philosophie de GoLive, on fait le quadrillage de la p4ge. - Palette > double-clic

sur (pour une fois changer). Dans la palette de l'inspecteur, on fixe les attributs de largeur
[width]et de hauteur [height]de la page, sans oublier de conf#es dimensions encodées.

* On met les outils de navigation. Procédure pour la boite de textdPadsite > double-clic sur

. On élargit cette boite de texte et on l'aligne a d = Tapez "Page d'accueil" dans la
boite de texte que I'on aligne également a d =teMettre "Page d'accueil" en surbrillance pour

effectuer le lien vers la page de présentation. Activation de l'icone ¢ ®2 2ipuis dans
I'Inspecteur se dirigeBfowse) dans le dossier "SiteGoLive" sur le fichier index.htm.

* On met le titre. Toujours la méme procédure de boite de texte. On élargit cette boite de texte et on
l'aligne au centre & . On encode le titre dans la boite de texte soit "Mon portrait chinois".

On peut centre le tex = . On donne au texte une taille 5, on le met en gras et en couleur.

* Oninseére un tableau de 5 lignes et 2 colonnes selon la procédure maintenant habituelle.

[Tatle “Bow el [Hidden

— Dimenzionz

Fiowz |5 Columns |2

widh 75 [Percent 7]
Height | I.-'l‘-.uh:u .
— fppearance
Barder |2_ [~ Colar I—
CelPad  [E CellSpace [
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* Vous obtenez un tableau qui prend la forme ci-dessous que vous complétez..

Couleur preférée Le bleu

Acteur preféré Tves Montand
Arctrice preferée Pamela Anderson
Cluffte prefére Le7

Pays préfére L'Espagne

» Enregistrez tout votre travail (oubli classiqueje - Save

» Votre exercice sur la création d'un site est ainsi terminé. En fait, maintenant que vous possédez les
outils de baseput commence vraiment!

» En attendant votre véritable premier site, admirez toujours celui-ci dans Explorer (ou dans
Netscape...).

* Ouvrir Microsoft Explorer. Pour ce faire cliquer son icone.
Pour rappel, puisqu'il s'agit d'un fichier local, on passer&iphier - Ouvrir = Parcourir -2
chemind'accés au répertoire "SiteGoLive"fichier index.htm=> Ouvrir .

1.10. Pour terminer ...

Les images sur Internet doivent étre au format gif ou jpeg.

Comme vous étes slrement habitué au format bmp des traitements de texte, il vous faudra passer par
un programme graphique pour faire les conversions. L'auteur vous recommande Paint Shop Pro,
disponible en shareware sur les CD-rom des brochures informatiques mensuelles ou téléchargeable
sur Internet. Les versions récentes comprennent méme un petit programme "Animation Shop" pour
faire des images gif animées du meilleur effet.

Pour commencer, vous pouvez toujours récupérer des images au cours de vos surfs sur le Web. |l
suffit de cliquer sur l'imagdgouton droit de la souris> Enregistrer I'image sous..

Do Lien

Ourir l2 lien dans une Mouvells fenétre
Enreqistrer la cible zous. ..

Imprimer Cible

Affichen limage

Enreaqistrer limage sous...
Etablir en tant que papier peint k

Une fois que vous avez votre image au format correct, enregistrez-la dans le méme répertoire que vos
fichiers Html (ici "Site GoLive").
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Pour inclure lI'image dans votre page Htiiew - Palette > double-clic ou drag/drop sj
Dans l'Inspecteur, on recherclBrqwse) I'adresse de l'image dans l'onglBasic'.

Image |nepectar

|Basi|: \I\Spec. \i M ap \i Lirik, \i.ﬁ.ctinns

Source |PUBHTM.gif
] [ Absolute Br-:w_\ise... I
|

Toujours dans l'lnspecteur mais dans l'ongBgtec!, il est recommandé de mettre un petit texte
relatif a I'image (Alt Text). On peut aussi mettre ou enlever une bordure a limage (Border).

Image Inspector

| | Easic \| Spec. wap \i Lirk. \i Actiohs

[T Border II:I— HSpace Il:l—
YWSpace IEI

Al Text . |Publication Html

s

Si on souhaite un lien a partir de I'image, dans l'ongliek
on rechercheBrowse) l'adresse de la page.

m

, aprés avoir activé l'icéne de il =2,

Image |napectar

|Basi|: \i Spec. \i M ap \i Lirik. \ké.ctinns

LIRL |[E mpty Referencel]

co cfa (2 [ | £bsalute Erglwse...l

N'oubliez pas que la taille des images est I'ennemi de la vitesse de la connexion. Inutile de prévoir des
photos panoramiques de votre école qui mettront 10 minutes pour étre chargées sur votre page Web.
Votre visiteur sera vraisemblablement déja en train de surfer sur un autre site que le vétre !

Avant de quitter les images, le langage Html vous offre la possibilité de mettre de petites images en
arriere-plan [background] qui viendront tapisser votre fond de page en mosaique. Ces images peuvent
aussi étre récupérées sur le Web. Il suffit de cliquer sur le fond de |dbpage droit de la souris

- Enregistrer l'arriére-plan sous...

ErecEdemte
Slamte

Enregistrer ['ariére-plan sous...

Etablir en tant que papier peint h

Pour inclure une image d'arriere-plan, il suffit de cliquer sur I'inet dans l'lnspecteur de la page
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Page |hspector

|F'age \LI;ITML \i Pending

— Background

[~ Colar I

[@] [T fhsalute  Browse.. |

Dans I'état actuel de la technologie, le navigateur n‘affichera réellement que les polices de caractéres
qui existent sur I'ordinateur du visiteur de votre site. La prudence et le classicisme s'imposent donc
(Times New Roman ou Arial). Il serait illusoire d'utiliser des polices de caractéres trés sophistiquées
gue votre "client" ne posséde peut-étre pas sur sa machine.

Le code source Html

Vous pouvez a tout moment voir (et modifier) le code source Html de votre page que vous éditez sous
GolLive par l'onglel =ource “: de la fenétre de I'éditeur.

Il serait trés pédagogique de consulter ce code Html aprés chaque opération (centrage, mise en gras,
alignement droite, création de tableau).

GolLive propose encore certaines fonctions qu'il sera bien temps d'utiliser plus tard (et parfois bien
plus tard ...).

Citons-en simplement quelques-unes :

» Les frames ou cadreJ,FfamT[El:

* Les images mapédsonglet "Map" de la fenétre de I'lnspecteur d'image.
» Dutiles propriétés des tableaux comme la fusion de cellules et la fraction de cellules.

» Mais en fait, les richesses de GoLive se regroupent dans la fEa@dtee L'onglet 'Basic' de la
Palette avec ses Floating Box, Plugin, Java, ActiveX, Javascript, Marquee et autre Anchor.
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» L'onglet 'Forms" de laPalette avec ses nombreuses possibilités pour les formulaires.

Palette

& IERGRIME=RENFE

SO REL
B R )
1}

» L'onglet 'Frames' de laPaletteavec ses nombreuses possibilités pour les cadres.

Falette

KR ERER[ERERER[=RERFZAN

DPEP0DEP -
PEOPDE
Jdirsws

WL

» L'onglet 'Cyber Objects' [?...] de laPalette avec ses possibilités d'animations.

Palette

[ERIERERFRERER[ERETR AN

CEIVAVETEC RS
° ¥

www.ccim.be/ccim328/html/index.htm
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